Release Notes

Keysight N491/BSCB 400G
Optical Recelver Test
Application

This document contains latest information on the Keysight N4917BSCB 400G Optical Receiver
Test Application.

The N4917BSCB 400G Optical Receiver Test Application succeeds the earlier N4917BSCA 400G
Optical Receiver Test Application with the difference that the N4917BSCB software has majorly
transitioned to a new licensing model, in addition to the Enhancements listed in this document.

Related Document
For detailed information, refer to the following document for this application:
- “Keysight_N4917BSCB_UserGuide.pdf”

This document can be found at the following location after you install the application:
C:\Program Files\ Keysight\M8070A\Apps\N4917BSCB\help

The M8070B/A documents can be located by clicking Start > All Programs > Keysight M8070B/A
> Keysight M8070B/A Documentation. Alternatively, you can also visit
www.keysight.com/find/m8070D to find the latest versions of M8070B/A documents.

KEYSIGHT

TECHNOLOGIES


http://www.keysight.com/find/m8070b
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Installation Steps

To install the N4917BSCB 400G Optical Receiver Test Application, perform the following steps:

1.

2.

Review the System Requirements for this application.

Download the installer file from:
http://www.keysight.com/find/N4917BSCB

Double-click the downloaded installer file on your PC.

Follow and respond to the installer prompts.

Accept the terms of the Keysight Software End-User License Agreement and click Next.
Click Install.

Click Finish to finish the installation and exit the installation wizard.

Install the required licenses via the Keysight License Manager (if not done before). To know
about the required licenses, refer to the Data Sheet.

Getting Started

To access the installed N4917BSCB application, perform the following steps:

1.

From the Start menu of the Windows Operating System, select All Programs > Keysight
M8070A Applications > Keysight N4917BSCB > Launch Keysight N4917BSCB.

If you are launching the Keysight N4917BSCB application for the first time, the End-User
License Agreement window appears. Select Agree to continue.
The N4917BSCB application banner is displayed.

If there is a single instance of the M8070B/A software running locally, the N4917BSCB
application launches after automatically getting connected to the M8070B/A software.

If the N4917BSCB application does not detect any instance of the M8070B/A software
running locally, the Connect to M8070 window appears.

When the application starts successfully, it will start with the default layout and will show
the Set Up tab.

For more information on how to use the various features in the N4917BSCB application,
refer to the Keysight N4917BSCB 400G Optical Receiver Test Application Online Help.


http://www.keysight.com/find/N4917BSCB
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Keysight N491/BSCB 400G Optical Receiver Test Application

Release V02.50.0001

The following table lists the supported hardware and firmware for the N4917BSCB application. An
“*” (asterisk) and bold text in this section indicates options required for 53.125 GBaud-based
standards.

Released Date: June 28,2019
Operating System: Microsoft Windows 7 (64 bit)
Microsoft Windows 8 (64 bit)
Microsoft Windows 10 (64 bit)
Memory 8 GB RAM [minimum]
Display resolution: WXGA+ (1440 x 900) [minimum]
PC Interfaces USB
LAN
GPIB (optional)
Instrument Firmware M8040A BERT - M8070B/A System Software. For the

supported versions see the Software Pre-requisites row.
DCA-M/DCA-X - FlexDCA version A.06.02.17 or later
8164B LMS - Ver.V5.25 or later

8149xA Ref Tx - Ver.5.01 or later

BERT M8040A-BU2 mainframe with USB option
M8070A-0TP/ONP/1TP/1NP System Software. For the
complete list of licenses for M8070B, see Chapter 2 of the
User Guide.

M8045A-G32/G64*/0G3/0G4/0P3/801 High Performance
BERT module

M8057A Remote head for M8045A pattern generator, 1
channel

M8046A-A32/0P3*/801 Analyzer module

Signal Generator for Sinusoidal and Gaussian Noise M8195A-002/16G Arbitrary Waveform Generator or
Interference M8196A-002 Arbitrary Waveform Generator

Lightwave Measurement System 8164B LMS Mainframe
Tunable lasers
81602A-013 Tunable Laser 1250-1370 nm or
81606A-113 Tunable Laser 1240-1380 nm or
81608A-113 Tunable Laser 1240-1380 nm or
81609A-113 Tunable Laser 1240-1380 nm

Reference Transmitters

81490A-EQ5 Reference Transmitter or

81490A-EQ9 Reference Transmitter or

81490A-E10 Reference Transmitter (multimode - for SR
only)

81491A-085 Reference Transmitter (multimode - for SR
only)

81491A-135 Reference Transmitter

81492A-E01* Reference Transmitter
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81000FI Optical Connector Interface
81000NI Optical Connector Interface

Optical attenuators:

81576A Attenuator module (straight SMF) or

81577A Attenuator module (angled SMF) or

N7761A external Attenuator (1 ch straight SMF) or
N7762A external Attenuator (2 ch straight SMF) or
N7764A external Attenuator (4 ch straight SMF)
N7751A external Attenuator (1 ch with 2 optical power
meter channels, SMF)

N7752A external Attenuator (2 ch with 2 optical power
meter channels, SMF)

N7766A Optical Attenuator for Multimode Fiber (2ch)
N7768A Optical Attenuator for Multimode Fiber (4ch)
8490D-010 - Coaxial Fixed Attenuator, DC to 50 GHz

DCA-X Oscilloscope N1000A DCA-X Wide-Bandwidth mainframe
86100D-ETR/PTB/200/300 DCA-X mainframe

86105D-281/IRC Electrical/Optical SMF module or
86115D-282 /IRC Dual Optical SMF module

86107A-020 Precision Time Base (not required, if DCA-X
has the option -PTB)

DCA-M Oscilloscope N1092A one optical channel or
N1092B two optical channels or
N1092C one optical, two electrical channels or
N1092D four optical channels or
N1092E two optical, two electrical channels
options LOJ/PLK/IRC/200/300/500

Clock Recovery N1078A Optical/Electrical Clock Recovery
N1077A-232/SMS/JSA Optical/Electrical Clock Recovery
N1076A/B-Electrical Clock Recovery

Software Pre-requisites: Keysight 10 Library rev. 18.1 or above
M8070B system software for M800O series ver. 6.0.210.6
or later and
M8070ADVB Advanced Measurement Package for M8000
series ver. 1.0.70.0
OR
M8070A system software for M800O series ver. 5.1.100.6
N1010A FlexDCA Remote Access System A.06.02.17 or
later
In the newer releases of FlexDCA, analysis packages that
combine many separate items that were available
previously under individual licenses are now available.
Refer to the Data Sheet to see how features of previous
FlexDCA releases map into the more recent FlexDCA
packages. For the N4917BSCB 400G Optical Receiver Test
Application, you require the following analysis package:

e N1010700A R&D Package
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Alternatively, use the older licenses:
e N1010A-9FP (PAM-N Analysis Software)
e N1010A-TFP (TDECQ Transmitter and Dispersion
Eye Closure for PAM4)

Application Requirements: Keysight M8070B/A System Software Version. For the
required licenses, see User Guide.
Keysight M8045A with options G32 or G64; 03G or UG3;
0G4 or UG4; OP3 or UP3 or OP6 or UP6
Keysight M8046A with options A32 or A64; OP3 or UP3
Keysight N4917BSCB 400G Optical Receiver Test
Application. For the required licenses, see User Guide.

File Name: SetupM80RXIEEE400G02500001.exe

Enhancements

- Updated licensing model.
o Support for USB portable/network licenses.
o Time-based license options are now available for all the license types.

For details, refer to https://literature.cdn.keysight.com/litweb/pdf/5992-3419EN.pdf.
Alternatively, contact Keysight Technical Support.

- Support for new optical IEEE 802.3cd (and relevant MSA) standards
400G-SR8, 200G-SR4, 100G-FR, 100G-LR, TO0GBASE-DR, 100G-SR2, 50GBASE-FR,
50GBASE-LR, and 50GBASE-SR. Because of the similarities in their targets and
implementation logic, the new multimode physical types (SR) are treated as a single
category in the N4917BSCB application.

- Support for “Noise Enhancement Factor” (Ceq) criterion and TX transition time
measurement introduced in IEEE 802.3cd calibration procedure.

- Support for new Keysight reference transmitter options: 8149TA-135 and 81491A-085
(multimode - for SR only).

- Support for new Keysight NTOO0OA DCA-X Wide-Bandwidth Oscilloscope Mainframe.

- Support for new M8070B System Software for M800O Series of BER Test Solutions. This
also requires M8070ADVB Advanced Measurement Package for M800O Series of BERT
Test Solutions.


https://literature.cdn.keysight.com/litweb/pdf/5992-3419EN.pdf
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- Support for new firmware versions
o MB8070B -6.0.210.6
= MB8070ADVB Advanced Measurement Package for M800O Series - 1.0.70.0
o MB8070A -5.1.100.6
o FlexDCA - A.06.02.17
o MB8195A SFP - 3.6

- Enhanced initialization procedure for DUT Control Interface (DCI) to enable support for
third-party error detectors. New configuration variables added for this purpose include:
DUT Control Interface Location and DUT Control Interface Address (in addition to the
existing DUT Control Interface Script File configuration variable).

- Support for auxiliary VISA instruments, e.g. optical switch, to switch between the setups
for calibration and testing. Two new configuration variables have been added for this
purpose, Auxiliary Instrument VISA Address and Auxiliary Instrument SCPI Command.

- Support for internal clock recovery in the newer M8046A error detector modules (requires
corresponding license option).

- Several usability enhancements

o New configuration variable “Test Result Aggregation” to control whether the newer
test results should replace or append to the existing test results, automatically, or if
the application should prompt whether to replace or append the older test results
with newer ones for each test run (default behavior).

o New configuration variable “Jitter Tolerance CDR LBW Auto” to enable or disable
the automatic loop bandwidth adjustment in case a clock data recovery (CDR) is
used during jitter tolerance testing. This configuration variable is available in the
Debug mode under the Configure tab.

o TDECQ filter tabs are now reported in stress calibration results.

- New configuration variable “Stress Signal Recall Pattern” to select which data pattern
(SSPRQ or PRBS31Q) to use for the calibration file to be recalled. The default behavior of
the application is to ask for the pattern during test execution.

- Enhanced calibration file handling when switching between standards and reloading
projects.

- New configuration variables “Ceq target value” and “ISI generation method” in view of
introduction of the IEEE 802.3cd transmission standards.
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Several new configuration variables in the Debug mode under the Configure tab:
Frequency Grid Mode, Frequency Increment Mode, Jitter Profile Frequency1, Jitter Profile
AmplitudeT, Jitter Profile Frequency?2, Jitter Profile Amplitude2, Jitter Profile Frequency3,
and Jitter Profile Amplitudes3.

Limitations

Limited support for the functionality of the “Upload Results to Repository” feature in the
Test Application.

Known Issues

Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB
RF attenuator might be required in the interference signal (SI + GN) path. Use this
approach when the calibration fails, and an error related to clipping of AWG amplitude is
reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB
user guide,.

When exporting calibration results as CSV file (File->Export Result...->CSV), the table
containing the stressed eye calibration results is not contained in the created file. Please
use the PDF or HTML file export instead.

During the installation of N4917BSCB Rev.2.5, a command window showing several
“Access denied” messages might be visible. These messages are caused by internal
installation processes and can be ignored and do not affect the installation success.

The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be
measured during the stress receiver signal calibration on the (TDECQ) filtered channel.
Though the measurement results will basically be the same as if measured on the
unfiltered channel, this configuration might be changed in future release versions.

The N4917BSCB software will automatically use a reduced Sl and GN amplitude when
using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior
can be disabled or configured using the following configuration variables

o Sl attenuator (true/false), Gaussian Noise attenuator (true/false)

o Sl channel attenuation, GN channel attenuation
available in “Debug Mode” under Configure (tab) -> Stress receiver signal calibration.

In case different attenuation values for Sl and GN channel are used, the same
configuration variables can also be used to shift the usable sinusoidal interferer to noise
ratio (“SIGNRatio”) to larger or smaller values

Exemplary calculation:

Sl attenuation: 10dB, GN attenuation: 10dB -> Sl to GN range: -13dB .. +17dB
Sl attenuation: 10dB, GN attenuation: off -> SI'to GN range: -23dB .. +7dB

Sl attenuation: off, GN attenuation: 10dB -> Sl to GN range: -3dB .. +27dB
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Laser safety errors are sometimes returned when the reference transmitter is calibrated,
and an external TLS source is used. As a workaround restart the test task or reduce the
maximum output power of the tunable laser (“Maximum TLS output Power” parameter in
the Configure tab).

When the Keysight N77xx Viewer software is connected via USB to a N77xx type
attenuator which is also used by the N4917BACA application, time-out errors might occur.
To prevent these errors during ORST testing, disconnect the N77xx Viewer software from
the attenuator.

Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due
to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress
receiver signal calibration > Calibration pattern).

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest)
if you encounter any other issue.


http://www.keysight.com/find/supportrequest
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Release V02.00.0002

The following table lists the supported hardware and firmware for the N4917BSCA application. An
“*” (asterisk) and bold text in this section indicates options required for 53.125 GBaud-based

standards.

Released Date:

August 24, 2018

Operating System: Microsoft Windows 7 (64 bit)
Microsoft Windows 8 (64 bit)
Microsoft Windows 10 (64 bit)
Memory 8 GB RAM [minimum]
Display resolution: WXGA+ (1440 x 900) [minimum]
PC Interfaces USB
LAN
GPIB (optional)

Instrument Firmware

M8040A BERT - M8070A System Software

86100D DCA-X - N1010A FlexDCA version A.05.80.158 or
later

8164B LMS - Ver.V5.25 or later

81490A Ref Tx - Ver.5.01 or later

BERT

M8040A-BU2 mainframe with USB option
M8070A-0TP/ONP/1TP/TNP System Software
M8045A-G32/G64*/0G3/0G4/0P3/801 High Performance
BERT module

M8057A Remote head for M8045A pattern generator, 1
channel

M8046A-A32/0P3*/801 Analyzer module

Signal Generator for Sinusoidal and Gaussian Noise
Interference

M8195A-002/16G Arbitrary Waveform Generator or
M8196A-002 Arbitrary Waveform Generator

Lightwave Measurement System

8164B LMS Mainframe

Tunable lasers

81602A-013 Tunable Laser 1250-1370 nm or
81606A-113 Tunable Laser 1240-1380 nm or
81608A-113 Tunable Laser 1240-1380 nm or
81609A-113 Tunable Laser 1240-1380 nm

Reference Transmitters

81490A-EQ5 Reference Transmitter or
81490A-EQ9 Reference Transmitter or
81492A-E01* Reference Transmitter

81000FI Optical Connector Interface
81000NI Optical Connector Interface

Optical attenuators:

81576A Attenuator module (straight SMF) or
81577A Attenuator module (angled SMF) or
N7761A external Attenuator (1 ch straight SMF) or
N7762A external Attenuator (2 ch straight SMF) or
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N7764A external Attenuator (4 ch straight SMF)
N7751A external Attenuator (1 ch with 2 optical power
meter channels, SMF)

N7752A external Attenuator (2 ch with 2 optical power
meter channels, SMF)

8490D-010 - Coaxial Fixed Attenuator, DC to 50 GHz

DCA-X Oscilloscope

86100D-ETR/PTB/200/300 DCA-X mainframe

86105D-281/IRC Electrical/Optical SMF module or
86115D-282 /IRC Dual Optical SMF module

86107A-020 Precision Time Base (not required, if DCA-X
has the option -PTB)

DCA-M Oscilloscope

N1092A one optical channel or

N1092B two optical channels or

N1092C one optical, two electrical channels or
N1092D four optical channels or

N1092E two optical, two electrical channels
options LOJ/PLK/IRC/200/300/500

Clock Recovery

N1077A-232/SMS/JSA Optical/Electrical Clock Recovery
N1076A-Electrical Clock Recovery

Software Pre-requisites:

Keysight 10 Library rev. 18.1 or above

M8070A system software for M800O series Ver. 5.0.228.4
or later

N1010A FlexDCA Remote Access System A.05.80.158 or
later

N1010A-9FP (PAM-N Analysis Software)

N10710A-TFP (TDECQ Transmitter and Dispersion Eye
Closure for PAM4)

Application Requirements:

Keysight M8070A System Software Version: 5.0.228.4 and
above with options OTP

Keysight M8045A with options G32 or G64; 03G or UG3;
0G4 or UG4; OP3 or UP3 or OP6 or UP6

Keysight M8046A with options A32 or A64; OP3 or UP3
Keysight N4917BSCA 400G Optical Receiver Test
Application

N4917BSCA-1FP or 1TP or INP or TUP or TFL or 1TL or
INL or TUL

File Name:

SetupM80ORXIEEE400G02000002.exe

Enhancements

- Support for 53 GBd-based standards - 400GBASE-DR4, 400G-FR4 (Lambda MSA Group)

- Full support for remote interface

- Addition of two new utility functions:

o Readjust reference transmitter power

o Recall aggressor channel

10
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Support for new reference transmitter 81492A-E01 (mandatory for all 53 GBd-based
standards, but supports 26 GBd-based standards as well)

Support of new firmware versions
o MB8070-5.0.228.4
o FlexDCA - A.05.80.158

Addition of new configuration parameters to support new 53 GBd-based standards and
enhanced usability: REFTX Recalibration Threshold, Switch off PG during REFTX recal,
Attenuator Settling Time, Optimize PAM4 Linearity, Skip receive power (OOMA) calibration,
DCA Clock Source, Clock Data Recovery Module, PG ClockOut Divider, Pause before
starting RX tests, Run ED Auto-Alignment before starting RX Tests, Error Detector
Alignment Threshold, Recall Aggressor Channel, Aggressor Channel Source, Aggressor
Channel Target, Error Detector Baud Rate, Error Detector Follow SYS Clock, Error Detector
Timeout, Clock Data Recovery Source, and Clock Data Recovery Loop Bandwidth

Several usability enhancements

o Generation of aggressor channel on second M8045A pattern generator output
channel (if available)

Usage:

The IEEE 802.3bs standard requires to use aggressor channels on all others than
the RX channel under test, so the N4917BSCA software Rev 2.0 offers a new
function to generate another electrical data output channel (if available in used
M8045A module).

The second data channel can automatically be configured during the start of a
receiver test (Configure (tab) > Receiver Testing > Recall aggressor channel > true)
or using the utility function “Recall aggressor channel”. As configuration source you
can choose between the following settings (Configure (tab) > Receiver Testing »
Aggressor Channel Source)

e PG Channel - Copies settings from PG channel to configure CH2
e Current setting - Recalls current settings for CH2 after BERT reset
e Configuration file - Uses XML configuration file from path:
c:\ProgramData\Keysight\M8070A\Apps\N4917BSCA\Info\DefaultAggress
orSettings.xml
o New optical power adjustment function to re-adjust the calibrated optical output
power due to a reference transmitter operating point drift.

Usage:

11
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The output power of the calibrated stress test signal must not change during RX
conformance testing to ensure the specified and calibrated OMA level. A possible
drift of the reference transmitter’s (REFTX) operation point would cause the output
power to change thus the measured optical power at the output of the attenuator
can be used to recalibrate the REFTX’s operation point. This can be done by using
the new “Readjust reference transmitter power” utility function.

o New configuration variable (Skip receive power (OOMA) calibration) to skip the final
optical power adjustment during stressed RX signal calibration

o Better organization of configuration parameters in logical groups

Limitations

Limited support for the functionality of the “Upload Results to Repository” feature in the
Test Application.

Known Issues

Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB
attenuator might be required in the interference signal (SI + GN) path. Use this approach
when the calibration fails, and an error related to clipping of AWG amplitude is reported
(Error message: Set range clipped).

The N4917BSCA software will use automatically use a reduced Sl and GN amplitude when
using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior
can be disabled or configured using “Debug Mode” (Configure (tab) > Stress receiver
signal calibration)

Laser safety errors are sometimes returned when the reference transmitter is calibrated,
and an external TLS source is used. As a workaround restart the test task or reduce the
maximum output power of the tunable laser (“Maximum TLS output Power” parameter in
the configure tab).

Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due
to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress
receiver signal calibration > Calibration pattern).

The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure

(tab) » Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to
calibration failure.

12
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Release VO1.50.1000

The following table lists the information that has changed from release v01.50.0000. For the
complete set of support information, refer to Release VO1.50.0000.

Released Date: March 27, 2018
File Name: SetupMB0RXIEEE400G01501000.exe
Fixes

- Fix for a problem with the AWG M8195A and M8196A firmware that caused an invalid
AWG sampling frequency (error message: “Clock is out of range.”) for the external
reference clock input.

Release VO1.50.0000

The following table lists the information that has changed from release v01.00.0000. For the
complete set of support information, refer to Release V01.00.0000.

Released Date: March 15, 2018

Instrument Firmware 81600D DCA-X - FlexDCA version A.05.71 or later
Software Pre-requisites: Keysight 10 Library rev. 18.1 or above

File Name: SetupM8ORXIEEE400G01500000.exe
Enhancements

- Support for dual error detector (M8046A) configuration for all the receiver tests
- Support for up to two clock data recovery modules as clock sources for receiver testing
- Addition of two new utility functions:

o Set PG transmission format

o Set ED detection format

- The “Optimize BERT deemphasis” utility function can be configured to run automatically
before every Stressed Receiver Signal Calibration

- Pauses in tests to enable manual settings before the error detector modules are aligned

- Support for new configuration parameters: Maximum TLS Output Power, Use Offline Mode,
Optimize deemphasis on calibration start, Pattern Generator Line Coding, Pattern
Generator Data, Error Detector Line Coding, Error Detector Data Pattern, Error Detector
Compare Mode, Error Detector Polarity, Error Detector (#1) Clock Source, Clock Data

13
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Recovery Module (ED #1), Error Detector (#2) Clock Source, and Clock Data Recovery
Module (ED #2).

- Better organization of configuration parameters in logical groups

- More comprehensive reporting of test results

Limitations

- Limited support for the functionality of the “Upload Results to Repository” feature in the
Test Application.

- Limited support for remote control features.

Known Issues

- The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure
(tab) > Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to
calibration failure.

- Stress signal calibration can only be carried out with SSPRQ pattern (Configure (tab) »
Stress receiver signal calibration > Calibration pattern).

Release VO1.00.0000

Released Date: December 6, 2017
Operating System: Microsoft Windows 7 (64 bit)
Microsoft Windows 8 (64 bit)
Microsoft Windows 10 (64 bit)
Memory 8 GB RAM [minimum]
Display resolution: WXGA+ (1440 x 900) [minimum]
PC Interfaces USB
LAN
GPIB (optional)
Instrument Firmware M8040A BERT - M8070A System Software

81600D DCA-X - FlexDCA version A.05.70.772 or later
8164B LMS - Ver.V5.25 or later
81490A Ref Tx - Ver.5.01 or later

BERT M8040A-BU2 mainframe with USB option
M8070A-0TP/ONP/1TP/TNP System Software
M8045A-G32/0G3/0G4/0P3/801 High Performance BERT
module
M8057A Remote head for M8045A pattern generator, 1
channel
M8046A-A32/0P3/801 Analyzer module

Signal Generator for Sinusoidal and Gaussian Noise M8195A-002/16G Arbitrary Waveform Generator or
Interference M8196A-002 Arbitrary Waveform Generator or
Any other source that is SCPI code compatible with the
Signal Generator listed above for setting frequency and

14
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output amplitude

Signal Generator for System Clock

You may optionally use system clock, if the internal clock
of the BERT is not used.

E8257D PSG Analog Signal Generator up to 67 GHz or
N5173B EXG X-series Microwave Analog Signal Generator
up to 40 GHz or

N5183B MXG X-series Microwave Analog Signal Generator
up to 40 GHz or

any other source that is SCPI code compatible with the
Signal Generators listed above for setting frequency and
output amplitude

Lightwave Measurement System

8164B LMS Mainframe

Tunable lasers

81602A-013 Tunable Laser 1250-1370 nm or
81606A-113 Tunable Laser 1240-1380 nm or
81608A-113 Tunable Laser 1240-1380 nm or
81609A-113 Tunable Laser 1240-1380 nm

Reference Transmitters
81490A-EO5 Reference Transmitter or
81490A-EQ9 Reference Transmitter

81000FI Optical Connector Interface
81000NI Optical Connector Interface

Optical attenuators:

81576A Attenuator module (straight SMF) or

81577A Attenuator module (angled SMF) or

N7761A external Attenuator (1 ch straight SMF) or
N7762A external Attenuator (2 ch straight SMF) or
N7764A external Attenuator (4 ch straight SMF)
N7751A external Attenuator (1 ch with 2 optical power
meter channels, SMF)

N7752A external Attenuator (2 ch with 2 optical power
meter channels, SMF)

DCA-X Oscilloscope

86100D-ETR/PTB/200/300 DCA-X mainframe

86105D-281/IRC Electrical/Optical SMF module or
86115D-282 /IRC Dual Optical SMF module

86107A-020 Precision Time Base (not required, if DCA-X
has the option -PTB)

DCA-M Oscilloscope

N1092A one optical channel or

N1092B two optical channels or

N1092C one optical, two electrical channels or
N1092D four optical channels or

N1092E two optical, two electrical channels
options LOJ/PLK/IRC/200/300/500

Clock Recovery

N1077A-232/SMS/JSA Optical/Electrical Clock Recovery
N1076A-Electrical Clock Recovery

Software Pre-requisites:

Keysight 10 Library rev. 17.2.20828 or above
M8070A system software for M800O series Ver. 4.0.0 or

15
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later

N1010A FlexDCA Remote Access System A.05.70.772 or
later

N1010A-9FP

N1010A-TFP

Application Requirements: Keysight M8070A System Software Version: 4.0.100.2 and
above with options OTP
Keysight M8045A with options G32 or G64; 03G or UG3;
0G4 or UG4; OP3 or UP3 or OP6 or UP6
Keysight M8046A with options A32 or A64; OP3 or UP3
Keysight N4917BSCA 400G Optical Receiver Test
Application
N4917BSCA-1TP or N4917BSCA-1NP

File Name: SetupM8ORXIEEE400G01000000.exe

Features

First release of Keysight N4917BSCA 400G Optical Receiver Test Application. The application
provides a platform for stressed receiver sensitivity test, which is compliant with automated
standards for 200GBASE and 400GBASE Optical Receiver Stress Testing. The solution consists of
several test instruments such as a Bit Error Rate Tester (BERT), an arbitrary waveform generator
(AWG), Digital Sampling Scope (DCA), Optical Reference Transmitter, Tunable Laser, and Optical
Attenuator operating together with the N4917BSCA software package.

Some salient features of the N4917BSCA 400G Optical Receiver Test Application include:
- Remote control of all the test instrumentation

- Automated calibration of the optical stressed eye parameters (ER, SECQ, and OMA)
following the procedure recommended by IEEE

- Adjustable target values for ER, SECQ, and OMA
- Automated Stress Receiver Sensitivity test

- Automated jitter tolerance compliance and margin tests

Known Issues
- Remote Interface feature (View > Preference > Remote) is not officially supported. For
instance, “Remote Interface Hint” (right click on  “Tests”™ or “Utility Functions™ in
Select Tests” Tab) or the reference manual (Help > Automation > Remote Interface) are
not final.

- The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure
(tab) > Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to
calibration failure.
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- Stress signal calibration can only be carried out with SSPRQ pattern (Configure (tab) >
Stress receiver signal calibration > Calibration pattern).

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you
encounter any other issue.

This information is subject to change without notice.
© Keysight Technologies 2017-2019
www.keysight.com
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